The Meeting Transcript of
The Los Angeles County

Board of Supervisors




March 2, 2010

The Meeting Transcript of
The Los Angeles County Board of Supervisors

Adobe Acrobat Reader

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF
document. Acrobat Reader looks for the word by reading every word on every page in the file,
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:
Match Whole Word Only finds only occurrences of the complete word you enter in
the box. For example, if you search for the word stick, the words tick and sticky will
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in
the box.

Find Backwards starts the search from the current page and goes backwards through
the document.
4. Click Find. Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

Choose Edit > Find Again
Reopen the find dialog box, and click Find Again.
(The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it
into another application such as a word processor. You can also paste text into a PDF
document note or into a bookmark. Once the selected text or graphic is on the Clipboard, you
can switch to another application and paste it into another document.

Note: If a font copied from a PDF document is not available on the system displaying the
copied text, the font cannot be preserved. A default font is substituted.

The Meeting Transcript of
The Los Angeles County Board of Supervisors
1




March 2, 2010

The Meeting Transcript of
The Los Angeles County Board of Supervisors

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

To select a line of text, select the first letter of the sentence or phrase and drag to
the last letter.

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option
(Mac OS) as you drag across the width of the document.

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command
(Mac OS) as you drag the length of the document.

To select all the text on the page, choose Edit > Select All. In single page mode, all the text
on the current page is selected. In Continuous or Continuous — facing mode, most of the text
in the document is selected. When you release the mouse button, the selected text is
highlighted. To deselect the text and start over, click anywhere outside the selected text.
The Select All command will not select all the text in the document. A workaround for this
(Windows) is to use the Edit > Copy command. Choose Edit > Copy to copy the selected
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the
Show Clipboard command until it is installed. To install the Clipboard Viewer, Choose
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows
Setup tab. Double-click Accessories, check Clipboard Viewer, and click OK.

The Meeting Transcript of
The Los Angeles County Board of Supervisors
2




The Los Angeles County Board of Supervisors

March 2, 2010

The Meeting Transcript of

10

11

12

13

14

15

16

17

18

19

20

21

[REPORT OF ACTION TAKEN IN CLOSED SESSION

TUESDAY, MARCH 2, 2010 BEGINS ON PAGE 179.]

SUP. MOLINA, CHAIR: GOOD MORNING. WE'RE GOING TO BEGIN THIS
MORNING'S MEETING. IF I COULD ASK EVERYONE TO PLEASE TAKE A
SEAT, WE'D APPRECIATE IT. THIS MORNING -- I'LL HAVE MY
INFORMATION HERE -- OUR INVOCATION WILL BE LED BY PASTOR J.M.
GARCIA, WHO IS WITH THE WORLD AFLAME MINISTRIES IN WHITTIER.
OUR PLEDGE THIS MORNING WILL BE LED BY ERNEST R. AMADOR, WHICH
IS WITH POST 247, ARCADIA, OF THE AMERICAN LEGION. WOULD YOU

ALL PLEASE STAND? PASTOR?

PASTOR J.M. GARCIA: FIRST OF ALL I WANT TO THANK THE MEMBERS
OF THE COUNTY BOARD OF SUPERVISORS FOR THIS OPPORTUNITY AND
GREAT PRIVILEGE THAT I HAVE TO BE HERE THIS MORNING. I'M
HUMBLED AND HONORED, THANK YOU. DEAR GOD, WE THANK YOU TODAY
FOR THIS OPPORTUNITY TO GATHER, TO BE OF SERVICE TO THE OUR
COUNTRY, OUR COMMUNITY, FELLOW MAN AND ULTIMATELY OUR WORLD.
AS THIS BOARD CARRIES OUT THEIR RESPONSIBILITY IN WORKING WITH
THE POLITICAL PROCESS AND HELPING TO NAVIGATE THOSE THINGS
THAT THEY NEED TO DEAL WITH DAILY, MONTHLY, HELP THEM, LORD,
WE PRAY AND NAVIGATE THIS SYSTEM WITH GRACE AND PATIENCE AND

GRANT THEM STRENGTH TO STAND UPON THEIR PRINCIPLES AND ETHICS
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1 WITH COURAGE AND PRIDE. WISDOM FROM ABOVE IS WHAT WE SEEK
2 DAILY TO IMPLEMENT THE RIGHT DECISIONS SO THAT THEY CAN

3 EFFECTIVELY CARRY OUT THEIR RESPONSIBILITIES AS PUBLIC

4 LEADERS. WITHOUT A DOUBT, WE UNDERSTAND THAT OUR ECONOMIC
5 INSTABILITIES BRING FEAR AND UNREST TO MANY OF US; HOWEVER, WE
6 TRUST IN THE KNOWLEDGE AND UNDERSTANDING WHICH IS SEATED RIGHT
7 HERE WITH THIS BOARD OF SUPERVISORS. AND WHEN THAT IS COUPLED
8 TOGETHER WITH THE WISDOM THAT COMES FROM ABOVE, WE ARE

9 CONFIDENT THAT EASE AND TRANQUIL WILL BE IN OUR COMMUNITIES.

10 DEAR GOD, HOLD THEIR HANDS, GUIDE THEM, SURROUND THEM WITH

11 YOUR GRACE ON THIS DAY. KEEP THEM AND THEIR FAMILIES SAFE

12 DATLY, AMEN.

13

14 ERNEST R. AMADOR: PLEASE FACE OUR NATION'S FLAG AND PLACE YOUR
15 HAND OVER YOUR HEART, YOUR RIGHT HAND, AND JOIN ME WITH IN

16 PLEDGING ALLEGIANCE TO OUR FLAG. (PLEDGE OF ALLEGIANCE

17 RECITED) .

18

19 SUP. MOLINA, CHAIR: IT IS INDEED MY HONOR THIS MORNING TO MAKE
20 A PRESENTATION OF A CERTIFICATE OF APPRECIATION TO PASTOR J.M.
21 GARCIA FOR A VERY INSPIRING AND MOVING INVOCATION, WHICH WAS
CERTAINLY NEEDED IN TIMES LIKE THIS. PASTOR GARCIA LEADS THE
CONGREGATION OF THE WORLD AFLAME MINISTRIES IN WHITTIER. THIS
THRIVING CHURCH OFFERS A NUMBER OF CARING MINISTRIES FOR THE

MANY PARISHIONERS INCLUDING MUSIC AND WORSHIP, CADET AND
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MENTORING AMONG MANY OTHERS. THERE ARE MANY GOOD WORKS

INCLUDING COORDINATING EDUCATIONAL CONFERENCES AND

CONTRIBUTING TO RELIEF EFFORTS ALL AROUND THE GLOBE. PASTOR
GARCIA IS AN ACTIVIST IN OUR COMMUNITY, ACTIVIST FROM THE
STANDPOINT OF PROVIDING A LOT OF LEADERSHIP TO COMMUNITIES, TO
THE COMMUNITY THAT HE IS MINISTERING IN. MORE RECENTLY, WE'RE
VERY PROUD TO GET RID OF A REALLY NUISANCE PROPERTY THERE. AND
SO THROUGH HIS LEADERSHIP AND THE LEADERSHIP OF MANY IN OUR
COMMUNITY. SO WE WANT TO THANK HIM FOR THE CONTRIBUTIONS, THE
SPIRITUAL WELL-BEING, AS WELL AS THE CONTRIBUTIONS HE MAKES TO
OUR COMMUNITY. CONGRATULATIONS SIR. ALL RIGHT. [APPLAUSE.]

SUPERVISOR ANTONOVICH?

SUP. ANTONOVICH: MADAM CHAIR, MEMBERS, ONCE AGAIN WE WANT TO
INTRODUCE ERNEST AMADOR, WHO LED US THROUGH THE PLEDGE OF
ALLEGIANCE. HE RETIRED FROM THE UNITED STATES ARMY, 32 YEARS.
LIEUTENANT COLONEL, ALSO A LAWYER. HE SERVED WITH THE 101ST
ATRBORNE IN VIETNAM, TET OFFENSIVE. HAS SIX CHILDREN AND
GRADUATED FROM CALIFORNIA STATE UNIVERSITY AT LOS ANGELES AND
THE UNIVERSITY OF CALIFORNIA OF LOS ANGELES. ATTENDED FREEMONT
HIGH SCHOOL, MY BROTHER'S ALMA MATER, AND IS ALSO A MEMBER OF
THE SCOTTISH RITE AND A 32ND DEGREE MASON. SO, ERNEST, THANK

YOU FOR COMING DOWN. [APPLAUSE.]
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SUP. MOLINA, CHAIR: ALL RIGHT. I'M GOING TO ASK OUR EXECUTIVE

OFFICER TO PLEASE CALL THE AGENDA.

CLERK SACHI HAMAI: GOOD MORNING, MADAM CHAIR, MEMBERS OF THE

BOARD. WE WILL BEGIN TODAY'S AGENDA -- BEGIN TODAY'S MEETING,
EXCUSE ME, ON PAGE 3. AGENDA FOR THE MEETING OF THE COMMUNITY
DEVELOPMENT COMMISSION. ON ITEM 1-D, THERE'S A REQUEST FROM A

MEMBER OF THE PUBLIC TO HOLD THIS ITEM.

SUP. MOLINA, CHAIR: OKAY. WE WILL HOLD THAT ITEM.

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING

AUTHORITY, ITEM 1-H.

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED
BY SUPERVISOR RIDLEY-THOMAS. IF THERE IS NO OBJECTION, SO

ORDERED.

CLERK SACHI HAMAI: BOARD OF SUPERVISORS ITEMS 1 THROUGH 12. ON
ITEM NO. 2, THIS ALSO INCLUDES SUPERVISOR RIDLEY-THOMAS'S
RECOMMENDATION AS INDICATED ON THE SUPPLEMENTAL AGENDA AND
ALSO SUPERVISOR RIDLEY-THOMAS AND MEMBERS OF THE PUBLIC

REQUEST THAT THIS ITEM BE HELD.

SUP. MOLINA, CHAIR: WE WILL HOLD THAT ITEM.
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CLERK SACHI HAMAI: ON ITEM NO. 6, SUPERVISOR KNABE AND A
MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. THE

REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU.

SUP. MOLINA, CHAIR: ON THOSE ITEMS, MOVED BY SUPERVISOR KNABE,
SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION,

SO ORDERED.

CLERK SACHI HAMAI: WE'RE NOW ON PAGE 9, CONSENT CALENDAR,
ITEMS 13 THROUGH 46. ON ITEM NO. 14, SUPERVISOR MOLINA,
SUPERVISOR KNABE AND MEMBERS OF THE PUBLIC REQUEST THAT THIS
ITEM BE HELD. ON ITEM NO. 24, THERE'S A REQUEST FROM A MEMBER
OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 26, SUPERVISOR
YAROSLAVSKY REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO

MARCH 9, 2010.

SUP. MOLINA, CHAIR: SO ORDERED ON THAT CONTINUANCE.

CLERK SACHI HAMAI: ON ITEM NO. 28, IT SHOULD BE NOTED THAT THE

RECOMMENDATION WAS REVISED ON THE SUPPLEMENTAL AGENDA AND ALSO

THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS

ITEM.

SUP. ANTONOVICH: TWENTY-EIGHT?
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2 CLERK SACHI HAMATI: YES. ON ITEMS NO. 41 AND 42 AS INDICATED ON
3 THE POSTED AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT
4 THESE ITEMS BE CONTINUED FOUR WEEKS TO MARCH 30, 2010. AND THE

5 REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU.

7 SUP. MOLINA, CHAIR: ALL RIGHT. ON THOSE ITEMS, MOVED BY

8 SUPERVISOR RIDLEY-THOMAS. SECONDED BY SUPERVISOR ANTONOVICH.
9 IF THERE'S NO OBJECTION, SO ORDERED.

10

11 CLERK SACHI HAMAI: WE ARE NOW ON PAGE 21, ORDINANCES FOR

12 INTRODUCTION, ITEMS 47 AND 48. AND I'LL READ THE SHORT TITLE
13 IN FOR THE RECORD. ON ITEM NO. 47, THIS IS AN ORDINANCE

14 AMENDING TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE TO
15 CHANGE THE SALARIES OF CERTAIN CLASSIFICATIONS AND TO MAKE
16 TECHNICAL CORRECTIONS.

17

18 SUP. MOLINA, CHAIR: ALL RIGHT. THAT ITEM IS MOVED BY

19 SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR KNABE.

20

21 CLERK SACHI HAMAI: ON ITEM NO. 48, THIS IS AN ORDINANCE

22 AMENDING TITLE 15, VEHICLES AND TRAFFIC OF THE LOS ANGELES
COUNTY CODE RELATING TO PARKING AT COUNTY PUBLIC LIBRARY

FACILITIES AND REMOVAL OF VEHICLES.
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1 SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH. SECONDED
2 BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO

3 ORDERED.

5 CLERK SACHI HAMAI: DISCUSSION ITEM. ON ITEM NO. 49, AS
6 INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE
7 OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO MARCH

8 9, 2010.

10 SUP. MOLINA, CHAIR: SO ORDERED ON THAT CONTINUANCE.

11 MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE
12 THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE
13 SUPPLEMENTAL AGENDA. ON ITEM NO. 50-A, THERE'S A REQUEST FROM
14 A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 50-B IS BEFORE YOU.
15

16 SUP. MOLINA, CHAIR: ALL RIGHT. ON THAT ITEM, MOVED BY

17 SUPERVISOR ANTONOVICH. SECONDED BY SUPERVISOR KNABE. IF

18 THERE'S NO OBJECTION, SO ORDERED.

19

20 CLERK SACHI HAMAI: AND THAT COMPLETES THE READING OF THE

21 AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH

SUPERVISORIAL DISTRICT NO. 3.

SUP. MOLINA, CHAIR: ALL RIGHT. ALL RIGHT WE HAVE A CONSUL

GENERAL PRESENTATION. THIS MORNING WE ARE WELCOMING A NEW
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CONSUL GENERAL, WELCOME. THANK YOU SO MUCH. TODAY WE'RE VERY
PLEASED TO HONOR -- TO WELCOME THE HONORABLE KAREN PROIDL, THE
CONSUL GENERAL OF AUSTRIA HERE IN LOS ANGELES. SHE HAS BEEN A
MEMBER OF THE AUSTRIAN DIPLOMATIC SERVICE SINCE 1992. HER
FOREIGN POSTINGS INCLUDE THE PERMANENT MISSION OF AUSTRIA TO
THE COUNCIL OF EUROPE AND AND STRASBURG, FRANCE, AND THE
PERMANENT MISSION IN THE UNITED NATIONS OF NEW YORK WHERE SHE
SPECIALIZED IN LEGAL AFFAIRS IN THE MIDDLE EAST. SHE ALSO
SERVED AS DEPUTY DIRECTOR OF THE AUSTRIAN CULTURAL FORUM IN
LONDON, AND THE DEPUTY HEAD OF THE AUSTRIAN EMBASSY IN ISRAEL.
AT THE AUSTRIAN FOREIGN MINISTRY HEADQUARTERS SHE SERVED IN
THE FOREIGN MINISTER'S CABINET AND IN THE HUMAN RIGHTS
DEPARTMENT. SHE EARNED A DOCTORAL DEGREE IN LAW FROM THE
UNIVERSITY OF AUSTRIA AND SHE STUDIED INTERNATIONAL LAW IN THE
SORBONNE IN PARIS. SHE ALSO HAS INTERNED AT UNESCO
HEADQUARTERS IN PARIS. AS CONSUL GENERAL IN LOS ANGELES, SHE
HAS JURISDICTION OVER 13 STATES FROM ALASKA TO NEW MEXICO AND
THE AMERICAN-ADMINISTERED PACIFIC ISLANDS. WE WANT TO PRESENT
A PLAQUE TO YOU AND HAVE AN OFFICIAL WELCOME TO LOS ANGELES.
WE HOPE YOU ENJOY YOUR TIME HERE AND YOUR WORK AND WE LOOK
FORWARD TO WORKING WITH YOU EVERY OPPORTUNITY WE HAVE A CHANCE

TO.

KAREN PROIDL: THANK YOU. [APPLAUSE.]
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1 SUP. MOLINA, CHAIR: WOULD YOU SHARE A FEW WORDS FOR US? I WILL

2 HOLD THIS FOR YOU.

4 KAREN PROIDL: MADAM CHATIR, DEAR MEMBERS OF THE BOARD OF

5 SUPERVISORS, I THANK YOU VERY MUCH FOR THE WARM WELCOME, WHICH
6 FOR ME IS A VERY, VERY NICE EXPRESSION OF THE FRIENDSHIP

7 BETWEEN THE COUNTY OF LOS ANGELES AND AUSTRIA. AUSTRIA HAS NOW
8 FOR 40 YEARS ITS CONSULATE GENERAL IN LOS ANGELES, AND WE HAVE
9 ESTABLISHED STRONG TIES ON ALL LEVELS. WE HAVE BROADENED THE
10 UNDERSTANDING AND THE APPRECIATION FOR EACH OTHER. AND WHAT T
11 THINK THIS IS THE PREREQUISITE FOR COOPERATION AND

12 PARTNERSHIP. I AND MY TEAM AT THE AUSTRIAN CONSULATE GENERAL
13 ARE BUILDING ON THE MANIFOLD EXISTING TIES, AND WE ARE OPEN

14 FOR NEW IDEAS AND PARTNERS. IT IS OUR AIM TO FURTHER BROADEN
15 THE NETWORKS AND TO FURTHER STRENGTHEN THE AWARENESS OF THE

16 PEOPLE OF LOS ANGELES COUNTY AND BEYOND OF AUSTRIA'S CULTURE,
17 OF THE AUSTRIAN PEOPLE AS DYNAMIC, INNOVATIVE AND CREATIVE, OF
18 AUSTRIA AS THE MODERN AND FORWARD-LOOKING COUNTRY IT IS, AND
19 ITS STRONG SOCIETY AND ECONOMY. AT THIS STAGE, I WOULD LIKE TO
20 TAKE THE OPPORTUNITY TO DRAW YOUR ATTENTION ALSO TO THE FACT
21 THAT AUSTRIA IS ALSO REPRESENTED BY THE AUSTRIAN TRADE
COMMISSION, WHO IS HEADQUARTERED HERE IN LOS ANGELES AND WHO
IS ACTUALLY FOCUSING ON GREEN TECH INFORMATION COMMUNICATIONS
TECHNOLOGY, TRANSPORTATION AND AVIATION, ELECTRONICS AND THE

SECURITY SECTOR. AND THEY'RE ASSISTING COMPANIES WHICH ARE
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1 BASED HERE IN LOS ANGELES COUNTY AND BEYOND WITH INEFORMATION
2 AND INTRODUCTIONS TO SUPPLIERS AND PARTNERS IN AUSTRIA WITH
3 EXCELLENT CONTACTS IN THE EUROPEAN AND TO THE EUROPEAN

4 MARKETS. DEAR MEMBERS OF THE BOARD OF SUPERVISORS, OUR

5 POLITICAL BACKING IS OF HIGHEST IMPORTANCE TO OUR WORK. AND
6 I'M GLAD TO SAY THAT WE HAVE A VERY STRONG SUPPORT FROM THE
7 AUSTRIAN GOVERNMENT FOR OUR WORK HERE IN LOS ANGELES, WORK

8§ WHICH IS BASED ON THE PRINCIPLE OF DIALOGUE AND COOPERATION,
9 MUTUAL RESPECT AND FRIENDSHIP. I THANK YOU VERY MUCH AGAIN FOR
10 THE WARM WELCOME, AND I'M LOOKING FORWARD TO WORKING WITH YOU
11 ON ISSUES OF MUTUAL CONCERN AND BENEFIT. THANK YOU VERY MUCH.
12 [APPLAUSE. ]

13

14 SUP. MOLINA, CHAIR: WELL THIS MORNING WE ALSO HAVE AN

15 ADDITIONAL PRESENTATION THAT MAKES US VERY, VERY PROUD. IT'S
16 MY HONOR TO PRESENT TO YOU THE MARCH 2010 L.A. COUNTY STAR IN
17 THE CATEGORY OF SERVICE EXCELLENCE AND ORGANIZATIONAL

18 EFFECTIVENESS. WE'RE ALWAYS HONORED TO MAKE PRESENTATIONS. WE
19 HAVE SO MANY EMPLOYEES THAT MAKE US PROUD EVERY SINGLE DAY,

20 BUT THERE ARE SOME THAT STEP UP AND BEYOND. AND WE'RE VERY

21 PROUD TO DO IT. WE WANT TO WELCOME DR. ELIZABETH BANCROFT EFROM
THE DEPARTMENT OF PUBLIC HEALTH. DR. BANCROFT HAS WORKED AT
THE DEPARTMENT OF PUBLIC HEALTH AS A MEDICAL EPIDEMIOLOGIST
FOR OVER 10 YEARS. I DIDN'T BRING MY GLASSES, I PROBABLY LEFT

THEM UPSTAIRS, FOR OVER TEN YEARS, INCLUDING TWO YEARS OF
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1 POST-DOCTORAL TRAINING IN THE CENTERS OF DISEASE CONTROL. SHE
2 GRADUATED FROM CORNELL UNIVERSITY MEDICAL COLLEGE AND THE

3 HARVARD SCHOOL OF PUBLIC HEALTH. AND SHE IS AN EXPERT IN

4 ANTIBIOTIC-RESISTANT BACTERIA INFECTIONS. THE DISCOVERY OF A
5 NEW STRAIN OF INFLUENZA IN SOUTHERN CALIFORNIA IN LATE APRIL
6 OF 2009 SET OFF AN UNPRECEDENTED FLURRY OF ACTIVITIES

7 THROUGHOUT PUBLIC HEALTH. DR. BANCROFT SUPERVISED THE

8 SURVEILLANCE OF ILLNESSES, HOSPITALIZATIONS AND DEATHS CAUSED
9 BY THE NEW INFLUENZA STRAIN. AND HER DEDICATED TEAM OF HEALTH
10 PROFESSIONALS DESIGNED A COMPREHENSIVE SYSTEM TO MONITOR THE
11 IMPACT OF THIS NEW FLU IN LOS ANGELES COUNTY. DR. BANCROFT

12 ALSO HAS EDITED FLU WATCH, A WEEKLY PUBLIC REPORT FOR

13 HEALTHCARE PROVIDERS AND THE PUBLIC IN SUMMARIZING THE

14 DEPARTMENT'S ACTIONS AND ITS FINDINGS, AS WELL. SHE HAS ALSO
15 PARTICIPATED IN COUNTLESS STATE AND NATIONAL SURVEILLANCE

16 MEETINGS, TRAINED STAFF TO INVESTIGATE PROTOCOLS, AND WORKED
17  WITH THE PUBLIC HEALTH LABORATORY TO ESTABLISH NEW TESTING

18 PROTOCOLS. SHE'S EVEN FOUND TIME TO CONDUCT A NUMBER OF

19 PROFESSIONAL TRAININGS FOR DOCTORS IN THE COMMUNITY, AND SHE
20 HAS ATTENDED TWO NATIONAL POLICY MEETINGS TO SHARE HER

21 EXPERTISE. THE DEMANDS AND CERTAINLY THE VOLUME OF WORK THAT
DR. BANCROFT WERE UNPRECEDENTED. THOUSANDS OF CASES AND
HUNDREDS OF OUTBREAKS OF RESPIRATORY DISEASE WERE REPORTED.
THROUGHOUT THE CRISIS, SHE EXPERTLY EVALUATED THOSE OUTBREAKS

AND IMPLEMENTED MEASURES TO REDUCE TRANSMISSION IN SCHOOLS AND
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1 THROUGHOUT OUR REGION. YOU CAN SEE WHY WE ARE SO PROUD OF THE
2  WORK THAT DR. BANCROFT HAS DONE. SHE HAS PAID SERVICE NOT ONLY
3 TO THE COUNTY BUT TO THE ENTIRE COUNTY'S WELL-BEING AND HAS

4 NATIONAL EXPERTISE IN THIS AREA. SO IT'S MY HONOR -- AND I'M

5 VERY PROUD TO MAKE A PRESENTATION THIS MORNING. SHE IS OUR

6 MARCH 2010 STAR COUNTY EMPLOYEE THAT'S DONE SO VERY WELL.

7 CONGRATULATIONS DR. BANCROFT. [APPLAUSE.] BEFORE I ASK DR.

8 BANCROFT TO SHARE A FEW WORDS, I'M GOING TO CALL ON DR.

9 FIELDING, IF HE WOULD.

10

11 DR. JONATHAN FIELDING: THANK YOU, MADAM CHAIR. ELIZABETH TRULY
12 IS A STAR. AND WHILE SOME OF THOSE WORDS MAY BE AWFULLY BIG,

13 WHAT SHE DOES IS TO PROTECT EVERYBODY IN L.A. COUNTY AND

14 NATIONALLY. SHE WAS THE ONE THAT WAS ASSIGNED TO FIGURE OUT

15 WHAT WAS GOING ON IN THE COUNTY JAILS WHEN THEY THOUGHT IT WAS
16 A QUESTION OF SPIDER BITES. TURNED OUT TO BE THE BEGINNING,

17 REALLY, OF A VERY LARGE EPIDEMIC OF M.R.S.A. AND ELIZABETH IS
18 NOW ONE OF THE NATIONAL EXPERTS ON THAT INCREASINGLY COMMON

19 AND SEVERE INFECTION. AS SUPERVISOR MOLINA INDICATED WITH FLU,
20 THERE WERE SO MANY DIFFERENT PIECES OF INFORMATION TO PUT

21 TOGETHER. IT'S A HUGE CONUNDRUM HOW YOU PUT ALL THOSE TOGETHER
22 AND SUMMARIZE THEM. SHE'S DONE A FANTASTIC JOB. AND THE FACT
THAT WE UNDERSTOOD WHAT WAS GOING ON AT EACH POINT, WHERE THE
TRENDS WERE, WHERE WE WERE SEEING MORE OUTBREAKS, HOW TO BEST

MANAGE IT IS LARGELY DUE TO HER CREATIVITY OR ENERGY AND HER

The Meeting Transcript of
The Los Angeles County Board of Supervisors
14




The Los Angeles County Board of Supervisors

March 2, 2010

The Meeting Transcript of

10

11

12

13

14

15

16

17

18

19

20

21

EXTRA EFFORT. AND SHE IS REALLY ONE OF THE TRULY GREAT STARS
IN OUR WONDERFUL DEPARTMENT AND SHARE RESPONSIBILITY WITH A
LOT OF PEOPLE BEHIND HER WHO WERE ALL GREAT FANS OF HERS, AS

AM I. SO, ELIZABETH, THANK YOU SO MUCH. [APPLAUSE.]

DR. ELIZABETH BANCROFT: THANK YOU. I WAS ASKED BY THE
SUPERVISOR IF THIS WAS MY FAMILY BACK HERE. AND REALLY, THIS
IS MY FAMILY AWAY FROM HOME. I'M FROM THE EAST COAST, BUT THIS
IS THE TEAM THAT DID THE SUPERVISION. AND REALLY, I ACCEPT
THIS AWARD IN THEIR NAME. IT WAS A TEAM EFFORT TO DO ALL THE
SURVEILLANCE FOR INFLUENZA. AND REALLY THIS IS FOR THEM. I SEE
THIS AS AN AWARD THAT REALLY RECOGNIZES THEM, AS WELL, AND A
LOT OF OTHER PEOPLE BACK AT THE OFFICE. AND IT COULDN'T HAVE
BEEN DONE WITHOUT THEM. AND IT COULDN'T HAVE BEEN DONE WITHOUT
THE LEADERSHIP OF MY SUPERVISOR, DR. DASSEY, DR. KIM FARLEY,
AND DR. FIELDING. AND I THANK THEM FOR THIS AWARD AND THIS

RECOGNITION. THANK YOU VERY MUCH. [APPLAUSE.]

SUP. MOLINA, CHAIR: THANK YOU, DR. BANCROFT. AGAIN,
CONGRATULATIONS TO ALL OF YOU. THANK YOU SO MUCH. WELL DONE.

THANK YOU. SUPERVISOR KNABE'S NEXT. ALL RIGHT.

SUP. KNABE: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD,
LADIES AND GENTLEMEN. IT'S MY PRIVILEGE TO ASK MR. RALPH

BUSTRUM OF THE BOY SCOUTS OF AMERICA, ALONG WITH HIS GRANDSON,
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JESSE, TO JOIN ME UP HERE. ALSO JOINING US IS EXECUTIVE

DIRECTOR OF THE LONG BEACH AREA BOY SCOUTS COUNCIL, MR. JOHN
FULLERTON. WE'RE RECOGNIZING, THE CITY OF BELLFLOWER HAD A
GREAT RECOGNITION AS WELL, TOO. BUT WE'RE RECOGNIZING RALPH
THIS MORNING FOR HIS 75 YEARS OF DEDICATED SERVICE TO THE BOY
SCOUTS OF AMERICA. 75 YEARS. [APPLAUSE.] HE HAS REMAINED A BOY
SCOUT FOR OVER SEVEN DECADES AND ROSE THROUGH THE RANKS TO
BECOME AN EAGLE SCOUT. CURRENTLY HE IS AN HONORARY MEMBER OF
THE POLARIS DISTRICT OF THE LONG BEACH AREA COUNCIL OF BOY
SCOUTS. HE EARNED AWARDS INCLUDING A SCOUT MASTER'S KEY, A
BRONZE PALM, THE NATIONAL SILVER BEAVER AWARD, WHICH IS HUGE.
HE HAS DEDICATED A LIFETIME OF SERVICE TO THE SCOUT LAW THAT
TEACHES TRUSTWORTHINESS, LOYALTY AND KINDNESS IN LIFE. RALPH
IS A RESIDENT OF BELLFLOWER IN THE FOURTH DISTRICT, A FORMER
CITY PLANNING COMMISSIONER. BUT LISTEN TO THIS, THIS IS
ANOTHER IMPORTANT PART OF HIS LIFE. HE WAS A DEDICATED
EMPLOYEE OF LOS ANGELES COUNTY WORKING AT RANCHO LOS AMIGOS
NATIONAL REHABILITATION CENTER IN DOWNEY FOR 33 YEARS.
[APPLAUSE.] HE HAS TWO SONS THAT WERE BOY SCOUTS AND A
DAUGHTER THAT WAS A GIRL SCOUT. HE HAS FOUR GRANDCHILDREN AND
TWO GREAT GRANDCHILDREN. SO ON BEHALEF OF THE BOARD AND THE
CITY OF BELLFLOWER AND THE ENTIRE FOURTH DISTRICT IN LOS
ANGELES COUNTY, WE WANT TO CONGRATULATE RALPH AND THANK HIM

FOR HIS 75 YEARS OF DEDICATION TO THE BOY SCOUTS OF AMERICA.
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1 [APPLAUSE.] DO YOU WANT THE SAY ANYTHING RALPH? SEVENTY-FIVE

2 YEARS, YOU GET TO SAY SOMETHING.

4 RALPH BUSTRUM: YEAH, FOR 75 YEARS HE SAID I COULD GET TO SAY
5 SOMETHING. BUT I WOULD THANK MY LIFE FOR BEING INVOLVED IN A
6 LOT OF SCOUTERS, SCOUTS AND SCOUTERS' LIVES. NOW THAT I'M 87
7 YEARS OLD, I CAN LOOK BACK NOW AND SEE SOME OF MY SCOUTS WHO
8 HAVE SONS AND NOW HAVE GRANDSONS WHO ARE IN THE BOY SCOUTS.

9 AND I ATTRIBUTE ALL MY LIFE IN SCOUTING TO THE VOLUNTEERS WHO
10 WORK BEHIND THE SCENES WHO HELP THE LEADERS AND ALSO OUR SCOUT
11 EXECUTIVES, THE COUNCIL OFFICE, WHICH WE GET OUR SUPPORT.

12 THANK YOU. [APPLAUSE.]

13

14 SUP. KNABE: NEXT WE HAD A VERY LIFESAVING RESCUE TAKE PLACE A
15 FEW WEEKS AGO RIGHT BY OUR CERRITOS REGIONAL PARK IN THE CITY
16 OF CERRITOS. I'M GOING TO CALL UP ANGEL BALTAZAR, TONY

17  WHITFIELD, ALVARO GARZON, AARON WHITE, BILL AND KATHLEEN

18 KOOIMAN, CARLOS RUBIO, DEPUTIES RAUL MARQUEZ, JASON JONES,

19 FRANK CORDOVA, AND ANTHONY MORGA. OKAY, THERE THEY ARE. I WANT
20 TO RECOGNIZE CHIEF TOM LANGE AND CAPTAIN JOE GONZALEZ OF THE
21 SHERIFF'S DEPARTMENT, AND JOE HEADS UP THE CERRITOS STATION.
THEY'RE UP HERE, AS WELL. AND RUSS GUINEY FROM OUR PARKS AND
REC DEPARTMENT, OUR DIRECTOR. ON JANUARY 5TH AT 5:58 P.M.,
THERE WAS A MAJOR TRAFFIC COLLISION AT 195TH STREET AND

BLOOMFIELD AVENUE IN THE CITY OF CERRITOS. THE DRIVER,
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GENESSIA MERCADO, WAS TRAPPED INSIDE A BURNING VEHICLE, HER
BURNING VEHICLE, WITH FLAMES THAT WERE 12 TO 15 FEET IN THE
AIR. THE COLLISION OCCURRED ACROSS THE STREET FROM OUR
CERRITOS REGIONAL COUNTY PARK. ANGEL BALTAZAR, A COUNTY
RECREATION SERVICES SUPERVISOR, WHO HAS BEEN RECOGNIZED BY
THIS BOARD IN THE PAST JUST ABOUT AT HER ANNUAL VISIT TO HELP
RESCUING PEOPLE. I THINK THE LAST TIME WAS ON THE 10 OR 60
FREEWAY. YEAH, GIVE HER A BIG ROUND OF APPLAUSE. [APPLAUSE.]
ANNUAL? NO. ANYWAY, SHE ASKED THE STAFF TO CALL 911. SHE
GRABBED A FIRE EXTINGUISHER FROM HER OFFICE, RODE HER BIKE TO
THE ACCIDENT. WITHOUT REGARD FOR HER OWN SAFETY, SHE BEGAN TO
EXTINGUISH THE FIRE WHILE OTHERS WERE TRYING TO REMOVE THE
VICTIM FROM THE CAR. THE FIRE REIGNITED AND SHE TRIED TO OPEN
THE CAR DOOR BUT IT WAS JAMMED. SHE WAS UNABLE TO BREAK THE
WINDOW WITH THE EXTINGUISHER AND HANDED IT TO TONY WHITFIELD,
WHO BROKE THE WINDOW. HE GAVE THE EXTINGUISHER BACK TO ANGEL
TO PUT OUT THE SECOND FIRE. ALVARO GARZON, AN OFF-DUTY
L.A.P.D. OFFICER, WAS JOGGING NEAR THE PAR, WHEN HE HEARD THE
COLLISION. HE WAS ON THE SCENE AND TRIED TO FREE MRS. MERCADO
AS WELL, BUT SHE WAS PINNED INSIDE THE VEHICLE. HE INSTRUCTED
AARON WHITE, A SECURITY GUARD FROM MOMI INTERNATIONAL, TO CUT
HER SEAT BELT AWAY. BILL KOOIMAN AND HIS WIFE, KATHLEEN, BILL
AND I HAVE GONE TO CHURCH TOGETHER FOR YEARS, A CHAPLAIN FOR
THE ORANGE COUNTY SHERIFF'S DEPARTMENT, WERE WALKING THEIR

DOGS IN THE PARK. WHEN THEY HEARD THE CRASH, THEY ALSO RAN TO
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1 THE SCENE AND GOT IN THE BACK SEAT OF THE CAR IN AN ATTEMPT TO
2 FREE THE DRIVER. SHERIFF'S DEPUTY RAUL MARQUEZ WAS THE FIRST

3 UNIT TO ARRIVE AT THE SCENE. HE GRABBED THE FIRE EXTINGUISHER
4 FROM HIS TRUNK, HANDED IT TO CARLOS. MR. RUBIO ASSISTED ANGEL
5 IN EXTINGUISHING THE FIRE. DEPUTY MARQUEZ KEPT THE

6 INTERSECTION CLEAR OF TRAFFIC SO EMERGENCY PERSONNEL COULD

7 RESPOND. DEPUTIES JASON JONES, FRANK CORDOVA AND ANTHONY MORGA
8 ARRIVED SHORTLY THEREAFTER AND USED THEIR FIRE EXTINGUISHERS

9 AS WELL TO SUFFOCATE THE SECOND FIRE. DUE TO THE QUICK AND

10 DECISIVE ACTIONS DISPLAYED BY THE MEMBERS OF OUR COMMUNITY,

11 AND OUR SHERIFF'S DEPARTMENT, MRS. MERCADO WAS SAVED FROM THE
12 FLAMES. THE LOS ANGELES COUNTY FIRE DEPARTMENT FINALLY REMOVED
13 THE VICTIM FROM THE VEHICLE WITH THE JAWS OF LIFE. SO WE WANT
14 TO, ON BEHALF OF THE BOARD, AND THE 10 MILLION RESIDENTS OF

15 LOS ANGELES COUNTY, COMMEND THESE INDIVIDUALS WHO OBVIOUSLY

16 JUST TOOK THAT EXTRA STEP BEYOND WITHOUT REGARD TO THEIR OWN
17 PERSONAL SAFETY TO SAVE A LIFE. AND SO THEIR EXTRAORDINARY

18 ACTIONS WERE INSTRUMENTAL, OBVIOUSLY, IN SAVING MRS. MERCADO'S
19 LIFE. SO LET'S GIVE THEM A BIG ROUND OF APPLAUSE. WE'RE GOING
20 TO PRESENT SCROLLS ONE BY ONE. [APPLAUSE.] LISTEN, YOU GOT TO
21 SEE THESE SCROLLS, THEY'RE PRETTY CUTE, ALL RIGHT. WE GOT
SUPERMAN, SUPER WOMAN. YEAH, YEAH. BUT FIRST OF ALL, AND AS I
MENTIONED IN MY COMMENTS TO ANGEL BALTAZAR, COUNTY PARKS
DIRECTOR OUT THERE AT CERRITOS REGIONAL, BUT THIS IS NOT HER

FIRST TIME IN PUTTING HER LIFE IN HARM'S WAY TO SAVE SOMEBODY.
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1 SHE DID IT ON THE FREEWAY ABOUT A YEAR AGO WE HAD HER DOWN

2 HERE. SO, ANGEL, CONGRATULATIONS. [APPLAUSE.]

4 SUP. MOLINA, CHAIR: THE SUPERWOMAN THING THERE IS GOOD.

6 SUP. KNABE: ISN'T THAT GREAT?

8 SUP. MOLINA, CHAIR: YEAH, IT'S COOL. VERY DESERVING.

10 SUP. KNABE: TONY WHITFIELD. ALL RIGHT, MAN. THERE YOU GO.

11 [APPLAUSE.] AARON WHITE. [APPLAUSE.] BILL AND KATHLEEN

12 KOOIMAN. [APPLAUSE.] ALVARO GARZON. [APPLAUSE.] I GOT THE BOSS
13 HERE. COME ON, BOSS. DEPUTY RAUL MARQUEZ. [APPLAUSE.] DEPUTY
14 JASON JONES. [APPLAUSE.] DEPUTY FRANK CORDOVA. [APPLAUSE.]

15 DEPUTY ANTHONY MORGA. [APPLAUSE.] ALL RIGHT. ANOTHER BIG ROUND
16 OF APPLAUSE, OUR HEROES. [APPLAUSE.]

17

18 SUP. KNABE: CONGRATULATIONS, THANK YOU. ALL RIGHT. MADAM

19 CHAIR, THANK YOU.

20

21 SUP. MOLINA, CHAIR: YOU DON'T HAVE ANY OTHER PRESENTATIONS?

SUP. KNABE: NO. I HAVE JUST HAVE THE ONE REUNIFICATION.
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SUP. MOLINA, CHAIR: OH. SUPERVISOR ANTONOVICH, YOUR

PRESENTATIONS?

SUP. ANTONOVICH: ONCE AGAIN WE WANT TO RECOGNIZE SAUGUS HIGH
SCHOOL'S GIRL CROSS COUNTRY TEAM. YOU REMEMBER THEY WERE HERE
PREVIOUSLY, AND THEY CONTINUE THEIR WINNING WAYS. WE HAVE BILL
BOLDE, THE PRINCIPAL, RENE PARAGUS, THE HEAD COACH, KATHRYN
NELSON, ASSISTANT COACH, AND BARBARA PHILLIPS, ALSO ASSISTANT
COACH, AND THEIR TEAM MEMBERS WHO ARE HERE. THIS IS A
REMARKABLE ACHIEVEMENT THAT SAUGUS HIGH SCHOOL HAS BEEN ABLE
TO ACCOMPLISH. EVEN LOCAL SPORTS FANS WHO DON'T FOLLOW CROSS
COUNTRY ARE PROBABLY FAMILIAR WITH THESE YOUNG LADIES. THEIR
FOURTH STRAIGHT C.I.F. STATE CHAMPIONSHIP, THE FIRST SUCH RUN
IN GIRLS' STATE HISTORY. THEY'VE BROKEN THE STATE RECORD FOR
FASTEST TEAM TWICE. THEY'VE WON FOUR STRAIGHT C.I.F. SOUTHERN
SECTION TITLES AND FOUR STRAIGHT FOOTHILL LEAGUE TITLES. THEY
HAVE SUCCESSFULLY DEFENDED MOUNT SAN ANTONIO COLLEGE, WHICH
THEY CONSIDER THEIR HOME COURSE, BY WINNING THE MT. SAC CROSS
COUNTRY INVITATIONAL THESE PAST FOUR YEARS. AT THE STATE
CHAMPIONSHIP LAST NOVEMBER, THE COACH ASKED THE GIRLS A SIMPLE
QUESTION: DO YOU WANT TO GO HOME IN THE VAN WITH THE SECOND
PLACE TROPHY? AND THEY ALL SAID, OF COURSE NOT, NO. AND THAT'S
THE WAY IT'S BEEN FOR THE PAST FOUR YEARS. AND WE'VE HAD THE
OPPORTUNITY TO HONOR THESE YOUNG LADIES BEFORE. THE CENTURIONS

WIN THEIR UNPRECEDENTED FOURTH CONSECUTIVE GIRLS' CROSS
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1 COUNTRY TIME WITH TEAM TIME OF ONE HOUR, 30 MINUTES, AND 26
2 SECONDS. A YEAR AFTER WINNING THE C.I.F. STATE DIVISION TWO

3 INDIVIDUAL CHAMPIONSHIPS AS A SOPHOMORE, JUNIOR KAYLIN MAHONEY
4 FINISHED THIRD OVERALL WITH A TIME OF 17 MINUTES, 35 SECONDS,
5 LEADING A CONTINGENT OF SEVEN SAUGUS GIRLS THAT FINISHED IN

6 THE TOP 72. OTHER FORWARD SCORERS WERE SOPHOMORE CARYS

7 FRANKLIN, WHO WAS FIFTH OVERALL AT 17 MINUTES AND 52 SECONDS.
8 JUNIOR STEPHANIE BOLDER WHO WAS 10TH AT 18 MINUTES AND 6

9 SECONDS, AND SENIOR AMBER MURICAMI WHO WAS 23RD AND 18 AND 26
10 SECONDS AND DANIELLE HERNANDO, WHO WAS 24TH WITH A TIME OF 18
11 MINUTES AND 27 SECONDS. SO THEY WOULD GO ON TO PLACE FOURTH IN
12 THE NATIONALS FOLLOWING THE WEEK IN OREGON, FINISHING WITH A
13 TIME OF 1 HOUR, 34 MINUTES, 56.40 SECONDS. AND THEY RETURNED
14 WITH 6 STARTERS FOR NEXT YEAR, SO WE LOOK FORWARD TO HAVING

15 THEM BACK AS WE GIVE THEM ANOTHER RECOGNITION FOR THEIR

16 ACCOMPLISHMENTS. THEIR PROGRAM AT SAUGUS GIRLS' CROSS COUNTRY
17 PROGRAM IS BETWEEN 2006 AND 2009 JOINS THE ARGUMENT AS ONE OF
18 THE GREATEST TEAMS IN THE STORIED HISTORY OF THE SANTA CLARITA
19 VALLEY ATHLETES. SO CONGRATULATIONS. WE LOOK FORWARD TO MANY
20 MORE OPPORTUNITIES TO RECOGNIZE YOU. AND LET ME GIVE YOU THESE
21 PROCLAMATIONS RIGHT NOW. FIRST TO THE COACH, RENE. [APPLAUSE.]
GOOD JOB. AND BARBARA PHILLIPS. AND KATHRYN NELSON. DANIELLE
HERNANDO. AND KAYLIN MAHONEY. AND CARYS FRANKLIN. AND
STEPHANIE BOLDER. AND ALEXIS HAMPTON. DANAE CHIRUCHI. EMILY

MCCARTY. AND MARISSA COTTO. AMBER MURICAMI. NICOLE PINICK.
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1 NICOLE? SO LET'S TAKE —-- FIRST LET'S ASK THE COACH, RENE,

2 SAY SOMETHING AND THEN WE'LL TAKE A GROUP PICTURE.

4 RENE PARAGUS: I JUST WANT TO SAY THANK YOU FOR THIS HONOR. AND
5 THESE YOUNG LADIES THAT YOU SEE BEFORE YOU ARE FIRST AND

6 FOREMOST STUDENTS. THE CROSS COUNTRY TEAM AT SAUGUS HIGH

7 SCHOOL ROUTINELY HAS THE HIGHEST G.P.A. OUT OF ALL THE SPORTS.
8 MANY OF THESE GIRLS ARE RANKED NUMBER ONE OR TWO IN THEIR

9 CLASS WITH G.P.A.S OVER 4.0. OUR ONLY SENIOR ON THE TEAM IS

10 GOING TO U.C.L.A. IN THE FALL TO CONTINUE HER EDUCATION AND

11 HER ATHLETIC CAREER THERE. SO THESE ARE VERY HARD WORKING

12 GIRLS AND WE'RE REALLY PROUD OF THEM. AND I'D ALSO LIKE TO

13 THANK MR. ANTONOVICH FOR SUPPORTING THE OPEN SPACES IN SANTA
14 CLARITA, SUCH AS THE TOWSLEY CANYON AND PLACERITA CANYON,

15 WHERE WE DO A LOT OUR RUNNING.

16

17 SUP. ANTONOVICH: YOU RUN OVER THERE?

18

19 RENE PARAGUS: YES, WE DO. [APPLAUSE.]

20

21 SUP. YAROSLAVSKY: I JUST WANT TO POINT OUT, MR. ANTONOVICH,
THAT THERE'S MORE BODY FAT ON MY BODY THAN ON THE ENTIRE TEAM

COMBINED. [LAUGHTER.] [APPLAUSE.]
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1 SUP. ANTONOVICH: NOW WE HAVE ONE OF OUR FINEST WHO IS GOING TO
2 BE RETIRING AFTER SERVING MORE THAN THREE DECADES AS A LOS

3 ANGELES COUNTY SHERIFF, AND THAT'S LIEUTENANT ART LUCAS WITH

4 HIS WIFE, LORRAINE, AND HIS MOTHER, MAE. HE'S SERVING 32 YEARS
5 WITH OUR SHERIFF'S DEPARTMENT, CAPTAIN TONG SUNIGA, LIEUTENANT
6 SEVERILLO RIVAS, SERGEANT DAN SCOTT, SERGEANT AL POJAJO,

7 SERGEANT PETER HAHN, SERGEANT BRIAN HUDSON, DEPUTY GILBERT

8 DOMINGUEZ, AND LIEUTENANT JAMES DELUNA ARE HERE TO RECOGNIZE

9 LIEUTENANT LUCAS FOR THESE 32 YEARS OF COUNTY SERVICE. HE

10 BEGAN BACK IN 1976 WITH THE CLASS OF '42 AND WORKED AS A

11 JAILER AT MEN'S CENTRAL JAIL BEFORE ENTERING THE SHERIFF'S

12 ACADEMY ON AUGUST 4, 1978 WHERE HE GRADUATED AS A DEPUTY

13 SHERIFF AMONG CLASS NUMBER 190. WHEREUPON HIS ASSIGNMENTS WERE
14 IMMEDIATE TRANSPORT AND AS A PATROL DEPUTY AND DETECTIVE AT

15 WEST HOLLYWOOD AND WORKED AS THE ANTITERRORIST TASKFORCE ON

16 THE ASTIAN ORGANIZED GANG SECTIONS AT THE SPECIAL

17 INVESTIGATIONS BUREAU. IN 1992 HE WAS PROMOTED TO SERGEANT,

18 WORKED AT THE NORTH COUNTY CORRECTIONAL FACILITY, THE WEST

19 HOLLYWOOD STATION, INTERNAL AFFATRS BUREAU AND INTERNAL

20 CRIMINAL INVESTIGATIONS BUREAU. THEN ON APRIL 16 IN THE YEAR
21 2000, HE WAS PROMOTED TO THE RANK OF LIEUTENANT AND WORKED AS
THE WATCH COMMANDER AT BOTH PITCHESS DETENTION CENTER, SOUTH
FACILITY AND EAST LOS ANGELES STATION, COMPLETING HIS CAREER
ASSIGNED TO THE SPECIAL VICTIMS BUREAU. SO WE WANT TO WISH

YOU, ART, A CONTINUED SUCCESS IN YOUR CAREER. AND NOW YOU CAN
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BECOME A RESERVE, RIGHT? THERE'S A LOT OF REGULARS BECOME
RESERVES, DO ANOTHER 32 YEARS. SO, ANYWAY, CONGRATULATIONS.

[APPLAUSE. ]

ART LUCAS: THANK YOU VERY MUCH. I APPRECIATE THE RECOGNITION
VERY MUCH. THE COUNTY AND THE SHERIFF'S DEPARTMENT'S BEEN VERY
GOOD TO ME. I'VE HAD SOME GREAT JOBS, BUT NONE BETTER THAN THE
ONE I CURRENTLY HAVE. CURRENTLY I WORK FOR THE SPECIAL VICTIMS
BUREAU. AND THESE ARE JUST SOME OF THE DEDICATED FOLKS THAT I
WORK WITH EVERY DAY. THESE FOLKS AND MANY OTHERS GO OUT AND
THEY PROTECT THE CHILDREN OF L.A. COUNTY. SO ONCE AGAIN, THANK

YOU VERY MUCH. [APPLAUSE. ]

SUP. ANTONOVICH: THE NEXT MOTION IS GOING TO BE A JOINT MOTION
WITH SUPERVISOR MOLINA, BUT LET ME -- THE JOINT MOTION WITH

MICHELLE VASQUEZ, DO YOU WANT TO DO IT TOGETHER?

SUP. MOLINA, CHAIR: YES, LET'S DO IT.

SUP. ANTONOVICH: I HAVE THE SCROLL HERE.

SUP. MOLINA, CHAIR: OKAY. LET'S DO THAT. I'M GOING TO ASK

JUDGE NASH TO JOIN US IF HE WOULD AND A WHOLE GROUP OF FOLKS

THAT ARE HERE. THE BOARD OF SUPERVISORS HAS PROCLAIMED MARCH 1

THROUGH 7 AS FAMILY REUNIFICATION WEEK. THIS WEEK-LONG
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1 CELEBRATION HONORS MOTHERS AND FATHERS WHO HAVE MET THE
2 DEPENDENCY COURT REQUIREMENTS AND SUCCESSFULLY REUNITED WITH

3 THEIR CHILDREN. WE'RE ALSO ACKNOWLEDGING THE MANY

4 ORGANIZATIONS AS WELL AS INDIVIDUALS WHO HAVE MADE KEY

5 CONTRIBUTIONS. JOINING US TODAY IS JUDGE MICHAEL NASH. HE IS

6 THE PRESIDING JUDGE IN LOS ANGELES JUVENILE COURT AS WELL AS

7 TRISH PLOEHN, OUR DIRECTOR OF CHILDREN AND FAMILY SERVICES.

8 UNDER TRISH'S GUIDANCE, THE DEPARTMENT HAS SIGNIFICANTLY

9 INCREASED SAFE REUNIFICATION. WE'VE IMPLEMENTED INNOVATIVE

10 PROGRAMS AND UTILIZED COMMUNITY-BASED RESOURCES, AS WELL, TO
11 REDUCE THE NUMBER OF CHILDREN THAT ARE GOING INTO OUR FOSTER
12 CARE PROGRAM. TODAY, EACH OF US AS SUPERVISORS ARE VERY PROUD
13 TO RECOGNIZE THE PEOPLE AND THE FAMILIES WITHIN OUR DISTRICTS
14 THAT HAVE DONE SO WELL IN THE REUNIFICATION. BUT BEFORE WE

15 HONOR EACH AND EVERY ONE OF THEM, I'M GOING TO ASK JUDGE NASH
16 IF HE WOULD JOIN US AND SHARE A FEW WORDS. HE HAS PROVIDED AN
17 AWFUL LOT OF LEADERSHIP TO MANY OF US WHO ARE MAKING POLICY OR
18 ATTEMPTING TO MAKE POLICY EVERY DAY, BUT TO THE DEPARTMENT, AS
19 WELL, SO THAT WE CAN MAKE SURE THAT AS WE REUNITE THESE

20 FAMILIES, THEY ARE GETTING THE SUPPORTIVE SERVICES, THEY'RE

21 MONITORED AND MORE IMPORTANTLY, THAT THE RESOURCES ARE THERE
FOR EVERY ONE OF THESE FAMILIES. JUDGE NASH, IF I COULD ASK

YOU TO JOIN US?
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1 JUDGE MICHAEL NASH: THANK YOU, SUPERVISOR MOLINA AND GOOD
2 MORNING, EVERYBODY. IT'S IMPORTANT THAT OUR COMMUNITY

3 UNDERSTANDS THAT OUR CHILD WELFARE SYSTEM IN LOS ANGELES DOES
4 A LOT OF THINGS. BUT THE ONE THING THAT IT DOES MORE THAN

5 ANYTHING ELSE IS MAINTAIN FAMILIES AND REUNIFY FAMILIES. AND

6 THAT IS OUR STATUTORY GOAL, OUR MORAL OBLIGATION; AND IT'S THE
7 ONE THING, AS I SAID, WE DO MORE THAN ANYTHING ELSE. SO THIS

8 WEEK AND TODAY WE'RE RECOGNIZING THAT FACT, AND TODAY WE'RE

9 RECOGNIZING A NUMBER OF INDIVIDUALS WHO EPITOMIZE FAMILY

10 REUNIFICATION. WE HAVE SOME FOLKS HERE WHO HAVE OVERCOME SOME
11 SIGNIFICANT OBSTACLES IN ORDER TO REUNIFY WITH THEIR CHILDREN.
12 WE HAVE OTHER FOLKS HERE WHO HAVE ASSISTED FAMILIES IN

13 REUNIFYING IN MANY DIFFERENT WAYS. AND SO WE'RE VERY HAPPY TO
14 BE HERE WITH EVERYBODY AND THANK YOU, SUPERVISOR MOLINA, FOR
15 GIVING US THE OPPORTUNITY TO DO THIS.

16

17 SUP. MOLINA, CHAIR: THANK YOU. PLEASURE. WELL, WE ALL KNOW AND
18 WE ALL HEAR THE HORROR STORIES FROM TIME TO TIME OF THOSE

19 INSTANCES IN WHICH WE AREN'T AS SUCCESSFUL AS WE'D LIKE TO BE
20 IN KEEPING OUR CHILDREN SAFE. BUT THERE ARE VERY MANY,

21 HUNDREDS AND HUNDREDS OF FAMILIES THAT OUR DEPARTMENT WORKS

22 WITH EVERY SINGLE DAY, WITH VERY TRAINED PROFESSIONALS THAT
TRY TO DO ALL THAT THEY CAN AND TO TRY AND ASSIST AND MAKE
SURE THAT THESE CHILDREN ARE REUNITED WITH THEIR FAMILIES. BUT

IT'S GOING TO BE REUNITED IN A WAY THAT'S POSITIVE AND
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PRODUCTIVE AND ENRICHING FOR THE CHILD. SO LEADING THAT TEAM
OF THOSE PROFESSIONALS AND THAT DEPARTMENT THAT GETS
CRITICIZED ALL THE TIME AND HARDLY EVER RECOGNIZED FOR THE
OUTSTANDING WORK THAT THEY DO IS THE DIRECTOR. TRISH PLOEHN,

WOULD YOU COME UP AND JOIN US AND SHARE A FEW WORDS?

TRISH PLOEHN: THANK YOU VERY MUCH, SUPERVISOR MOLINA. I JUST
WANTED THE THANK SUPERVISOR MOLINA AND THE ENTIRE BOARD OF
SUPERVISORS FOR MAKING SURE THAT EVERYONE KNOWS THAT FAMILY
REUNIFICATION IS IMPORTANT AND THAT THE IMPORTANCE TO A CHILD
OF BEING RAISED IN THEIR OWN FAMILY WHEN THAT CAN HAPPEN
SAFELY IS OF CRITICAL IMPORTANCE. THAT HASN'T BEEN THE WAY
IT'S ALWAYS BEEN IN THIS COUNTY. TWENTY YEARS AGO, WE USED TO
TAKE CHILDREN INTO CARE AND OFTENTIMES NOT RETURN THEM. AND
THAT IS NOT THE WAY WE DO BUSINESS ANYMORE. WE BELIEVE IN THE
IMPORTANCE OF FAMILIES. WE BELIEVE THAT CHILDREN BELONG WITH
THETIR FAMILY AND THAT IS THE WAY THAT CHILDREN ARE GOING TO
GROW UP TO BE SAFE AND PRODUCTIVE ADULTS. AND SO WE'RE SO
PLEASED THAT THIS BOARD HAS HONORED THAT BELIEF BY THIS
CELEBRATION TODAY AND ALL WEEK LONG. AND I WANTED TO OFFER A
VERY SPECIAL THANK YOU TO JUDGE NASH, BECAUSE HE HAS SHOWN
LEADERSHIP, NOT ONLY LOCALLY BUT ACROSS THIS NATION ABOUT THE
IMPORTANCE OF KEEPING CHILDREN SAFELY TOGETHER. SO I JUST
THANK ALL OF YOU FOR BEING HERE TODAY AND FOR HONORING THE

FAMILIES. AND ESPECIALLY THE PEOPLE THAT ARE HERE BEHIND ME
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1 BECAUSE IT'S THEIR HARD WORK THAT GOT THEIR FAMILIES TO COME
2 BACK TOGETHER AND FOR ALL OF THE SUPPORTERS AND ALL OF THE

3 ADVOCATES AND ALL OF OUR PARTNERS THAT ARE HERE TODAY AND THAT
4 ARE LISTENING TODAY, THANK YOU FOR BELIEVING IN THE IMPORTANCE

5 OF FAMILY. THANK YOU. [APPLAUSE.]

7 SUP. MOLINA, CHAIR: IT TRULY TAKES A WHOLE COUNTY RAISE A

8 CHILD, THERE IS NO DOUBT. ONE OF THE VERY IMPORTANT AND

9 SIGNIFICANT FACTOR